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IBM’s statements regarding its plans, directions, and intent are subject to 
change or withdrawal without notice at IBM’s sole discretion. 

Information regarding potential future products is intended to outline our 
general product direction and it should not be relied on in making a purchasing 
decision. 

The information mentioned regarding potential future products is not a 
commitment, promise, or legal obligation to deliver any material, code or 
functionality. Information about potential future products may not be 
incorporated into any contract. The development, release, and timing of any 
future features or functionality described for our products remains at our sole 
discretion.



Before We Begin...
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▬ IBM Lotus® Component Designer 6.0
▬ JavaServer™ Faces (JSF) Tooling IBM® Rational® Application Developer 
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● Software Developer: Iris Associates / Lotus Development
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▬ IBM Lotus® 1-2-3® for Unix®, 
▬ LotusScript, etc.

● Author
▬ Mastering XPages
▬ XPages Portable Command Guide
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● XPages Runtime
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● Customer Enablement & Proof-of-Concept development
● Co-creator of global XPages@... Workshops

– Lotus OneUI Adoption Workgroup
● Author

▬ Mastering XPages
▬ XPages PCG
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A New Development Model
● The IT Landscape is evolving quickly and we need to adapt to these changes

– Product release cycles do not match the community expectations

– Some Notes/Domino releases may not have an application development focus

– We need shorter cycles and sharper focus for the app dev community

● The XPages Extension Library proved that open-sourcing the code has several benefits:

– We can release as fast as we want, and customers can adopt it at their convenience

– The availability of the source code makes it easier to consume, understand, and extend
● But....

– The open source projects are not officially supported by IBM
● can be a blocker in some organizations

– The code is not certified with IBM quality standards 
● localization, accessibility, testing etc.



  

Product, Upgrade Packs and Open Source
● Code is first released on OpenNTF

– Available early and gives full transparency on what is being done

– Facilitates quicker user evaluation, feedback and contributions
● Pieces from OpenNTF are selected and delivered as “Upgrade Packs”

– Upgrade Packs are supported by IBM

– Upgrade Packs are delivered on a shorter release cycle than products

– Upgrade Packs are integrated into the next revision of the product 

– Upgrade Packs do not modify the core base platform in any way !

Core Product

Continuous development released as open source

UP1 UP2 UPy...

N/D 8.5.3 N/D “Next”

...UPx...
Dec 14, 2011
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What is Upgrade Pack 1 ?
● XPages Extension Library UP1

– A set of Java plug-ins that greatly extend XPages runtime functionality

– Works on web, Notes client and mobile devices

– Installs on top of Notes/Domino 8.5.3

– Applicable to Domino, XWork Server, Notes, Domino Designer

– Cool new Domino Designer enhancements for Ext Lib controls

– A fully accessible runtime library and templates 
● A11Y certified
● Enhanced TeamRoom and Discussion templates

– Online documentation 

– Runtime is localized

– Built to IBM globalization standards

– Implemented using the XPages Extensibility API

– Officially supported by IBM

– Includes source code ! 

● Domino Access Services: 

– New REST APIs



  

The Extension Library
● What's in Extension Library UP1? 

– Over 100 new tags !!!
– UI controls | Data Access Objects | Simple actions | Other assets … 

● Dojo wrappers
● iNotes controls
● REST services
● Mobile library
● New @Functions
● Predefined Managed Beans
● Application Layout 

● Get Started with XPagesExt.nsf
– Sample application available on OpenNTF.org
– Provides intuitive samples of almost every artifact

● Learn even more from the TeamRoom and Discussion templates 
– Features a new mobile UI



  

Productizing the Extension Library
● Official support for the Extension Library starts with 8.5.3 UP1

– “Productized” version 
● Accessible, localized, fortified, enhanced

● Future Proofing XSP Markup

– UP1 involved a line-by-line examination of every control declaration

– Had to be compliant with IBM product guidelines and standards

– Breaking changes
● Ext Lib XSP markup update released on Nov 17, 2011 (20111117-1058)
● Applications based on Ext Lib before this date may require an upgrade
● Typically this is just a simple property name substitution and rebuild

– e.g. from “title” to “label”
– We tried to minimize any breaking changes as much as possible

– All the breaking changes are documented



  

Enhanced Domino Designer Tooling
● New customized property panels for advanced controls

– Application Layout
– DataView

● Design Pane visualizations for all controls
● New Property Pickers/Editors 

– Domino View Picker
– Bitwise Option Picker
– Regular Expression Editor
– Currency Picker … etc.

● Updated tooltips 



  

How do I get 8.5.3 Upgrade Pack 1?
● Customers on active maintenance can download from Passport Advantage

–  CI5GIEN

● IBM Business Partners can use Partnerworld Software Access Catalog
– http://tinyurl.com/IBMPartnerWorldCatalog

● Download 1 image (~ 400 megabytes)



  

How do I install 8.5.3 Upgrade Pack 1?
● Notes/Domino Add-On Installer 

– Domino server

– Notes client

– Domino Designer

● All platforms supported

– Windows ® | Mac | Unix flavors

● Upgrade Pack Uninstall

– Platform Add/Remove Programs

● Supports Silent Install
● Supports Smart Upgrade



  

What is installed?
● Help > About > Component Details (Notes Client or Domino Designer)

XPages Core Component

UP1 
Features

Other Notes Components



  

What is installed?

● Source Code

– Eclipse plug-ins containing Java source code for all UP1 Extension Library modules

● Application Templates

– teamrm8xl.ntf and discussion8xl.ntf

– Template names have xl suffix and do not overwrite classic NTFs

– * Discussion template installed with Notes client (no Teamroom)

– DocLib 'xl' template now available for preview on OpenNTF.org

Source Code

Designer Tooling

App Templates

Ext Lib Runtime

App Templates

Ext Lib Runtime

App Template *

Ext Lib Runtime



  

Extension Library - Installed from OpenNTF.org

XSP 
Core 

Plugins

Ext Lib 
Plugins

● Help > About > Plugin Details (Notes Client or Domino Designer)

Ext Libx
 Plugins

● Help > About > Plug-in Details (Notes Client or Domino Designer)
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Extension Library Plug-in Model 

XPages Core Runtime
(ND 8.5.3)

XPages Extension 
Library

(UP1 | OpenNTF.org)

XPages Experimental 
Extensions

(OpenNTF.org)

extsncore

.rcpdomino

.xsp.extlib domino OneUI mobile

.xsp.extlibx relational social etc

XPages Core Runtime Library
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Extended Editing Context

In Context Editing
Modal Dialog

Tooltip Dialog

Dynamic Tabbed Interface

● Beyond the traditional web form/submit/navigate pattern
● Editing the data “In Context”
● Provide various flavors of dialogs
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Dynamic Pages
● Make the content of a page dynamic
● Parts of the page are discarded/reconstructed on demand
● The user never leaves the current page
● Very efficient runtime behavior
● The context is kept using the URL hash technique
● Makes it “bookmarkable”, and enables the back button
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Value and Name Pickers
● Select data from any data source
● Domino view, Address Book, Managed Bean..
● Integrated with the standard TypeAhead component
● Pluggable UI for high degree of customization
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Outlines/Menus
● Provide a generic way for building action bars
● Hierarchical navigators, accordions, pop-up menus, 

trees...
● Content can be static (defined in the page), dynamic 

(retrieved from a data source) or a mix of both.
● Easy mapping to actions (client and/or server side)
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Dojo Wrappers

● Leveraging the Dojo form controls
● Extended set of input controls
● Spinner, sliders,...
● Dojo client side validation enabled
● New Dojo containers for high user interactivity
● Tabbed panels, layout...
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Interactive Views
● View content rendered in a scrollable grid
● Either the Dojo grid or the iNotes virtual list, depending on the need
● iNotes virtual list supports categorization, document hierarchy...
● Dojo grid supports editing and is not tied to Views
● Data is accessed using REST services provided by the XPages
● Custom columns can be computed, and events handled
● Documents can also be updated for the column pointing to fields
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OneUI Application Layout
● Get a running OneUI application in less than 5 minutes!
● Fully customizable OneUI rendering
● Abstracts all the OneUI application parts
● Can even be customized by providing an inherited renderer
● Get ready for the upcoming Vulcan look and feel
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Access to Calendar Views
● Visualize Notes/Domino views through iNotes controls and REST services
● Add CRUD operations through custom forms



30

Predefined Managed Beans
● Get easy access to common data
● Current user name, email, etc.
● There also new @Functions ...

–  You could add your own Managed Beans and @Functions



  

Source Code
● Java source code for all modules provided as Eclipse plug-ins
● Source can be used to:

– Understand fine detail of how features work

– Customize runtime behavior *

– Propose new features or behaviors

– Diagnose issues

● Setting up a development environment to work with Java source code

– Server must be started in debug mode (add entries to NOTES.INI)
● JavaEnableDebug=1
● JavaDebugOptions=transport=dt_socket,server=y,suspend=n,address=8000

– Install Domino Debug Plugin into Domino Designer
● http://tinyurl.com/XPagesDominoDebugPlugin

– Import Java source plug-ins into Domino Designer
● Ref Step #8 in Domino Designer install instructions

– Set up Domino server and OSGI debug configurations

● Use Firebug or other script debuggers to work with JavaScript source

– Firebug, Firebug Lite (XPiNC), IE Developer Toolbar etc

http://tinyurl.com/XPagesDominoDebugPlugin


  

Mobile Controls

● Single-Page Application Paradigm
– Application Pages loaded using partial refresh
– Pages typically written as Custom Controls
– Share Logic between Desktop/Mobile

● Supported Devices
– Themes provided for iPhone and Android in UP1
– Intention to support Blackberry in future Upgrade Pack



  

Mobile Controls
● Application
● Application Page
● Heading
● List
● List Item
● Switch
● Tab Bar
● Tab Bar Button
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Next Steps

● Get the 8.5.3 Upgrade Pack 1 code
– Requires 8.5.3 base -- There's never been a better reason to upgrade !!! 

● Quick Win – Apply new Teamroom and Discussion templates
– In two easy steps!

●  File > Application > Replace Design
●  Run Agent > Upgrade Content 
●     note: you only need to run agent once !

● Demo & Tutorial
– http://www.openntf.org/blogs/openntf.nsf/d6plinks/NHEF-8MHA78
– http://www-10.lotus.com/ldd/ddwiki.nsf/dx/XPages_Mobile_Controls_Tutorial

● For more info on Dojo mobile controls:
– http://dojotoolkit.org/features/mobile
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Enablement Materials
● Online documentation available on Domino Designer wiki

– http://tinyurl.com/Doc4XPagesUP1

● New Extension Library Book 

– Comprehensive 600 page volume

– IBM Press publication

– Authored by a team of all-star XPages experts,
Featuring contributions from key community members

– Take full advantage of the XPages Extensibility
Framework, Library & API

– Step-by-step guide for developers of all experience levels

– Combines reference material and practical use cases

● Estimated Availability Q2 – 2012

– www.ibmpressbooks.com/bookstore/product.asp?isbn=0132901811

– www.amazon.com/XPages-Extension-Library/dp/0132901811

http://tinyurl.com/Doc4XPagesUP1
http://www.ibmpressbooks.com/bookstore/product.asp?isbn=0132901811
http://www.ibmpressbooks.com/bookstore/product.asp?isbn=0132901811
http://www.amazon.com/XPages-Extension-Library/dp/0132901811
http://www.amazon.com/XPages-Extension-Library/dp/0132901811
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Other NEW XPages Books
● XPages Portable Command Guide

– Compact 300 page volume

– IBM Press publication

– Authored by members of XPages & Domino Designer dev teams

– Perfect complement to the popular Mastering XPages book,
helping experienced XPages developers go even further

– Thoroughly covers XSP properties, Command Manager
instructions, INI variables, OSGi console commands,
debugging, logging and more.

– Dozens of practical examples providing immediate solutions

– www.ibmpressbooks.com/bookstore/product.asp?isbn=0132943050

– www.amazon.com/XPages-Portable-Command-Guide/dp/0132943050

http://www.ibmpressbooks.com/bookstore/product.asp?isbn=0132943050
http://www.ibmpressbooks.com/bookstore/product.asp?isbn=0132943050
http://www.amazon.com/XPages-Portable-Command-Guide/dp/0132943050
http://www.amazon.com/XPages-Portable-Command-Guide/dp/0132943050
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Before You Leave ...

● Please complete your session survey

● The Grand Tour of XPages in Notes/Domino 8.5.3 Upgrade Pack 1
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Thank You

M erci
Grazie

Gracias
Obrigado

Danke

Japanese

French

Russian

GermanItalian

Spanish

Brazilian Portuguese

Arabic

Traditional Chinese

Simplified Chinese

Hindi

Tamil

Thai

Korean

Buochasí
Irish
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Legal disclaimer
© IBM Corporation 2012.  All Rights Reserved.

The information contained in this publication is provided for informational purposes only. While efforts were made to verify 
the completeness and accuracy of the information contained in this publication, it is provided AS IS without warranty of any 
kind, express or implied. In addition, this information is based on IBM’s current product plans and strategy, which are subject 
to change by IBM without notice. IBM shall not be responsible for any damages arising out of the use of, or otherwise related 
to, this publication or any other materials. Nothing contained in this publication is intended to, nor shall have the effect of, 
creating any warranties or representations from IBM or its suppliers or licensors, or altering the terms and conditions of the 
applicable license agreement governing the use of IBM software.

References in this presentation to IBM products, programs, or services do not imply that they will be available in all countries 
in which IBM operates. Product release dates and/or capabilities referenced in this presentation may change at any time at 
IBM’s sole discretion based on market opportunities or other factors, and are not intended to be a commitment to future product 
or feature availability in any way. Nothing contained in these materials is intended to, nor shall have the effect of, stating or 
implying that any activities undertaken by you will result in any specific sales, revenue growth or other results. IBM, the IBM 
logo, Lotus, Lotus Notes, Notes, Domino, PartnerWorld and Lotusphere are trademarks of International Business Machines 
Corporation in the United States, other countries, or both. Unyte is a trademark of WebDialogs, Inc., in the United States, other 
countries, or both.

 Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or 
both.Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. Other company, product, or 
service names may be trademarks or service marks of others.

All references to [insert fictitious company name] refer to a fictitious company and are used for illustration purposes only.
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